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The days of time-consuming postcard preparation and tedious 

confirmation phone calls are over. Communication Manager works 

seamlessly with Dentrix to automate your reminder process and 

reduce missed appointments.

Dentrix Communication Manager reminds your patients with emails, postcards and text messages.

Reduce Missed Appointments!
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Learn more about automating your appointment 
 reminders at: www.dentrix.com/appointmentbliss

   1-800-734-5561

With Communication Manager your practice will:

•  Reduce no-shows with a robust reminder process

•  Improve front office productivity with automated communications

•  Eliminate costly inventory with print-on-demand postcards

•  Increase patient base with friend and family referrals

Now with 2-Way SMS, patient confirmations via text message 
post real time to the Dentrix Appointment Book!
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Get more out of your Dentrix investment with the Dentrix 
Profitability Coaching Program. This unique program is designed 
to turn your Dentrix practice management solution into a more 
effective profit-boosting tool. 

Let our experts show you how to put all the features of Dentrix 
to work for your practice, and help you identify the reports and 
performance metrics you should focus on for greater profitability.

You’ll learn ways to:

•	 Keep patients coming back

•	 Complete treatment plans faster

•	 Increase treatment acceptance rates

•	 Get timely insurance payments

•	 Give more accurate patient estimates

•	 Keep your schedules filled

 “The Profitability Coaching Program has been 

extremely helpful to our practice. We spend 

most of our time taking care of our patients, 

so we don’t really have time to tinker and 

learn everything the software can do for us.”

~LeighAnn, Dr. Jason Lowry, Kingman, AZ

BOOST YOUR PROFITS WITH 

PROFITABILITY COACHING

In TouCh

This exclusive one-year coaching program 
offered to our customers for the low price 

of only $875. To take advantage of this 
special offer call us at 1-800-DEnTRIX or visit 

www.Dentrix.com/ProfitabilityCoaching today!



F r o m  t h e  e D i t o r

Easy Access to Dentrix Tips

occasionally we receive phone calls from readers who tell us, “We 

didn’t receive our copy of Dentrix magazine. Please send us another 

one.” We love these calls. it’s good to know that people read the 

magazine and find helpful information in the news, feature articles, 

and departments. 

For example, Dentrix News reports on recent and upcoming 

enhancements to Dentrix and the many integrated eServices; How 

It Works explains how to read essential Dentrix reports, like the new 

Practice Advisor report; and other regular columns provide practical 

Dentrix “how to” tips for every member of the dental office team. 

You probably already know that four times a year we send a printed 

copy of Dentrix magazine to dental practices on a Dentrix Customer 

Service Plan. But what you may not know is that Dentrix magazine is 

also available online. 

every member of your team can download current and past issues of 

Dentrix magazine at www.dentrix.com/magazine. Save the current 

issue on every computer and iPad in your office, and give your team 

members easy access to the tips they need to increase the efficiency 

and profitability of your practice. 

As Sean eyring says in his article, Thrive with Dentrix Training (page 

14), “the bottom line is that when you provide training for your team, 

along with the tools they need to do their jobs, they thrive—and so 

does your practice.” 

Download your free PDF of Dentrix magazine today at www.dentrix.

com/magazine. 
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CoVer StorY: inStAnt meSSAGinG in 
the DentAL oFFiCe

thriVe With Dentrix trAininG

10

14

A preview of Dentrix Dentalink, the 
new intra-office instant messaging tool 
created specifically for dental offices.

Whether you like to discover new 
information at your own pace or prefer 
receiving training in a group setting, you 
can find a Dentrix training option that will 
help you and your practice thrive.



Get Dentrix news, tips 
anD information

The DenTal Business

ProDucT informaTion

Training anD suPPorT

TiPs anD Tricks

ParTner ProDucT

siGn up toDay at 
www.Dentrix.com/newsletter

and don’t miss out on the most up-to-date Dentrix information!
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The Dentrix eNewsletter will help you stay up-to-date 

on the latest Dentrix product information, education 

opportunities, industry news, tips and tricks, 

promotional offers and more! 

Once a month you’ll receive an eNewsletter 

featuring the following content:

www.Facebook.com/Dentrix  

www.Twitter.com/Dentrix  



DentrIx MagazIne | 3

Questions & Answers

Q: in the Batch Processor, what does a 
status of “Schd-1” mean? 

A: When you send a report to the Batch Processor, the 
report’s status appears in the Status column. A “Schd-1” 
status (or “Schd-” followed by some other number, such as 

“2” or “3”) means the report is printing, being previewed, or is 
still loading. if you see a “Schd-1” status that doesn’t change 
to another status after you finish printing or previewing the 
report, from the File menu, click refresh. if the status doesn’t 
change to “Printed,” try deleting and re-creating the report 
or restarting your computer. For additional troubleshooting 
steps, see knowledgebase articles 34033 and 23781 in the 
Dentrix resource Center.

Q: How long do reports stay in the Batch 
Processor? 

A: reports stay in the Batch Processor until you delete them 
or until you upgrade to a newer version of Dentrix; there is no 
time limit.

Q: Do i have to delete old reports from 
the Batch Processor or can i keep all  
of them in the list? 

A: the Batch Processor can store many reports. however, after 
months of generating reports you may find the office manager 

taking a long time to load, or you may find yourself having to 
scroll down in the Batch Processor list before you find the desired 
report. For these reasons, it is recommended that you delete 
reports in the Batch Processor after you no longer need them. 

Q: in the Batch Processor, can i choose to 
delete only the items that i’ve already 
printed/sent?

A: Yes. in the office manager, from the File menu, click 
Delete. From the Delete options dialog box, you can choose 
to delete only Selected reports, Printed/Displayed reports, 
Sent reports (claims or bills that have already been sent), or 
all reports. 

Q: if i delete a report from the Batch  
Processor, can i get it back?

A: no. however, Dentrix reports, bills, and claims can be re- 
generated by creating the report again using the same date range 
and options as used previously. etrans transmission reports are 
the exception; they are one-time receipts indicating the status of 
your eClaims submissions and cannot be regenerated after you 
delete them. if you want to save and archive certain reports, you 
can “print” them to the Dentrix Document Center where you can 
organize and archive them electronically. in the office manager, 
click File > Printer Setup and change your reports printer to the 
Dentrix Document Center printer, and then print the reports you 
want to archive. 

Dentrix Resource Center
the Dentrix resource Center offers an online library of 

on-demand software tutorials and product manuals, a tech-

nical support knowledgebase, and opportunities to register 

for webinars with Dentrix experts. Access is free for dental 

practices on a Dentrix Customer Service Plan. Log in today at 

www.dentrix.com/resource-center.

MyVoIce for Dentrix
Do you have an idea for a new feature in Dentrix? Do you 

want to share it with the Dentrix product managers and other 

Dentrix users? Visit myVoice for Dentrix where you can share 

your great ideas and “vote up” the best ideas shared by 

others. Vote today at www.dentrix.com. Click the Share Your 

opinion link in the “Join our Community” section. 

Dentrix Help Files
in the Dentrix help Files, you can explore a comprehensive 

list of conveniently indexed topics or search the topics for key 

words. to search the help files, from the Help menu in any 

Dentrix module, click contents, click the Search tab, type a 

search phrase or topic name, click list topics, and then under 

Select topic, double-click the topic name. tip: to turn off the 

search highlights, press F5. 

Dentrix eNewsletter
Sign up for the free Dentrix enewsletter and receive tips 

for using Dentrix, practice management advice from industry 

consultants, and news about product releases and training 

events. Sign up today at www.dentrix.com/newsletter. to read 

previous articles, visit www.dentrix.com/newsletter-archive. 

HOw TO LeaRN MORe
if you want to learn more about the Dentrix tips featured in Dentrix magazine, check out these self-paced learning resources.
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 eSync Appointment Status Updater

the latest eSync plug-in is the Appointment Status 
Updater. With the Appointment Status Updater, when 
patients submit their completed forms from an in-office kiosk, 
the appointment status in the Dentrix Appointment Book is 
updated automatically—in real-time. this allows the entire 
team to see when a patient is ready to be taken to the opera-
tory without the need for additional communication.

“this new functionality adds even more efficiency to an 
already efficient process,” said Adam mcDaniel, eServices 
Product manager. “the kiosk software greatly improved the 
speed at which patient data could be imported into Dentrix. 
now it has become a complete patient check-in tool by 
updating the Appointment Book status automatically when 
the patient is ready for treatment.”

Dentrix users can customize the appointment status that 
appears in the Appointment Book. they can set up statuses 
like “Patient has arrived” or “ready for operatory” to display 
in the Dentrix Appointment Book when patients submit their 
completed forms through a kiosk. 

the Appointment Status Updater also provides automatic 
real-time appointment status updates for patient confirma-
tions from email appointment reminders and text messages. 
offices can set up custom appointment statuses for these 
types of appointment confirmations. 

the Appointment Status Updater is available as part of 
eSync, a free application that automates communication 
between eCentral and Dentrix. to download eSync and the 
eSync installation Guide, visit www.dentrix.com/products/
eservices/esync. 

For information on using the Appointment Status Updater, 
see the eSync help. From the eSync window, click the Help 
icon, then locate the “Appointment Status Updater Plug-in 
overview” help topic. You can also learn more about eSync 
by visiting www.dentrix.com/products/eservices/esync or by 
calling 800-734-5561.

Dentr ix  news

With henry Schein DDx, henry Schein’s web-based case 
management tool, practices can submit customized digital 
lab prescriptions instantly to their dental labs, reducing the 
common communication and prescriptions errors that slow 
offline case management processes. DDx also offers the added 
benefit of detailed lab case and account management capabili-
ties like electronic account statements, electronic payments, 
and integrated shipping alerts, totally free for the dental prac-
tice. And, Dentrix users can instantly pre-populate a DDx lab 
slip with one click from the Patient Chart, Appointment Book, or 
treatment Planner. 

in response to significant growth within its Dentrix user base, 
henry Schein DDx will release exciting practice-side updates in 
november 2011. Dentrix users will enjoy increased visibility into 

their entire business with any DDx-enabled lab, including the 
ability to invite peers to join the DDx network, view new labs that 
join the DDx network, and participate in enhanced training and 
tutorials for practice staff. 

“DDx has always given labs and practices a complete 
picture of their business together,” said Sandy macDonald,  
DDx Product manager. “the new features improve business 
insight for dental offices of any size, with special focus on 
enabling peers to join and share case information. the new 
features also provide customizable, tiered user access and 
reports, such as those needed by multi-location and large 
group or enterprise providers.” 

other new features coming in november 2011 take practice-
to-lab communication one step further, with the offering of DDx 
lab websites that provide updated information about the lab to 
practices, such as cases shipped that day and contact informa-
tion. Using DDx, labs will have the ability to broadcast news and 
specials to their DDx practices and their DDx website instantly. 

Visit www.ddxdental.com for more information about submit-
ting and tracking lab cases online in seconds—for free—with DDx. 

 Coming Soon: Henry Schein DDX Enhancements 
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 PowerPay 5.0

henry Schein has responded to changes in PCi security 
standards with a new version of PowerPay, its popular credit 
card processing software. PowerPay 5.0 exceeds the latest 
security requirements and provides exciting new features that 
lower transaction rates, improve practice branding, and allow 
the software to run on the latest computer systems. 

With the enhancements to PowerPay, office administrators 
have greater control in restricting access and tracking payment 
history. “PowerPay has always been very secure,” said Adam 
mcDaniel, eServices Product manager. “the new features go 
even further to protect dental offices and their patients from the 
fraud potential that exists in credit card processing.” 

PowerPay 5.0 lowers transaction fees by automatically 
posting credit card verification information. other new 

features improve ease and convenience, like the ability to post 
receipts and consents to the Document Center or the ability 
to calculate the number of payments and payment amounts in 
the consent screen. 

other new features in PowerPay 5.0 improve practice 
marketing and branding. A practice logo or message can now 
be added to some PowerPay hardware, including the newly inte-
grated ingenico 6580 color pin pad and the ePad Vision color 
signature capture device. Plus, you can now add customized 
messages to the receipt footer to more effectively communicate 
and reinforce dental offers or other information.  

PowerPay 5.0 is now compatible with Windows 7 and 64-bit 
technology. “enabling PowerPay to run on the latest computer 
systems has been one of our most frequent requests. We’re 
pleased that customers who upgrade their hardware can now 
benefit from this powerful software,” said mcDaniel. 

Visit www.dentrix.com/powerpay or call 800-734-5561 for 
more information about streamlining credit card processing and 
managing accounts receivable balances more effectively. 

With eCentral 2.9, patients can confirm appointments by 
replying to text message reminders. When you use eCentral  
in conjunction with the new eSync Appointment Status 
Updater, patients’ appointment statuses will be automatically 
updated in the Dentrix Appointment Book when they confirm 
with a text message. 

“eCentral Communication manager is now an even more 
effective tool for reducing the need for confirmation calls,” 
said Adam mcDaniel, eServices Product manager. “this new 

functionality allows Dentrix practices to interact with patients 
in ways they’re accustomed to outside of the dental world. 
technology is changing and we want to give our customers the 
tools to change with it.”

Another new feature in eCentral 2.9 gives users the ability 
to create customized text messages. now when users send 
text messages to patients, they can use a pre-written message 
template or create custom messages from scratch. 

to learn how to send text message appointment reminders 
with Dentrix and eCentral 2.9, visit www.dentrix.com/getting-
started/text-message. For more information about what’s new 
in eCentral 2.9, see the “What’s new in eCentral 2.9?” topic 
in the eCentral help Files. You can also learn more about 
eCentral and eSync by visiting www.dentrix.com/eservices or by 
calling 800-734-5561.

 eCentral 2.9 Text Messaging Improvements 



to ensure your practice is as profitable as 
possible, it’s important to track key performance 
indicators, or kPIs. the Dentrix Practice advisor 
shows your practice’s kPIs in several categories, 
including new patient analysis. to access the 
Practice advisor, in the office Manager, click 
analysis, then Practice advisor. or, click the 
Practice advisor button.

how it  works:
The new Patient Analysis Section  
of the Practice Advisor report 

this row shows the dollar amount of the treatment 
accepted by new patients (#1). the following 
procedures are counted in this amount:

•	 treatment-planned procedures that (a) are part of a 
treatment case with an “accepted” status and (b) have a 
procedure date that is the same as the patient’s first visit 
date in the Family File.

•	 Completed procedures that either (a) have a treatment-
planned date that is the same as the patient’s first visit 
date in the Family File or (b) have a procedure date that is 
the same as the patient’s first visit date in the Family File.

this row shows the dollar amount of the treatment 
diagnosed for new patients (#1). the following 
procedures are counted in this amount:

•	 treatment-planned procedures that (a) are part of a 
treatment case with an “accepted” status and (b) have a 
procedure date that is the same as the patient’s first visit 
date in the Family File.

•	 Completed procedures that either (a) have a treatment-
planned date that is the same as the patient’s first visit 
date in the Family File or (b) have a procedure date that is 
the same as the patient’s first visit date in the Family File.

this row shows the number of new patients (#1) who  
were referred to your practice by another patient. 

Patients are counted in this number if they have a “patient 
referral”  recorded in the  Family File and if that referral has 
the same date as their first visit date. 

this row shows the total number of new patients 
who visited your practice for the first time within the 
selected date range.

Patients are counted in this number if the date in the First 
Visit field in the Family File is within the selected date range 
and if they have a “patient” status. 

the number in the mtD column of this row is used as the 
basis for calculating the other new patient statistics. 
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For a full explanation of each row 

and column in the new Patient 

Analysis section of the Practice 

Advisor report, see the new 

Patient Analysis topic in the Dentrix 

Help. you can also visit the Dentrix 

resource Center and view the 

Practice Advisor tutorial. See “How 

to Learn More” on page 3  for instruc-

tions on accessing these resources.

this row shows the number of new patients (#1) who 
were referred to your practice by either a patient, 
doctor, or marketing campaign.

Patients are counted in this number if they have any kind 
of referral (#5, 6, 7) recorded in the Family File and if that 
referral has the same date as their first visit date. 

this row shows the average dollar amount of the 
treatment diagnosed for new patients. this number 
is calculated by dividing the treatment amount 

diagnosed (#2) by the number of new patients (#1).

this row shows the number of new patients (#1) who  
were referred to your practice by a doctor or other 
specialist.  

Patients are counted in this number if they have a “doctor 
referral”  recorded in the  Family File and if that referral has 
the same date as their first visit date.

this row shows the number of new patients (#1) who  
were referred to your practice by an advertisement or 
marketing campaign. 

Patients are counted in this number if they have a 
“non-person referral”  recorded in the  Family File and if 
that referral has the same date as their first visit date. 

to set up non-person referrals, create a new referral type 
(such as “Website”) and check the non-Person check box 
in the referred By Information dialog box. 
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TechCentral. Your One Source 
Partner For Office Technology.
So you can focuS on managing your practice.

• Computers

• NetworkiNg

• wireless

• Audio/Video

• support plANs

technology changes fast. You need a trusted expert with the right office computer and networking 
solutions for your business needs and budget. see why Henry schein techCentral is the leading 
provider of integrated technology solutions and support for dental practices nationwide.

Call 877.483.0382 or vist www.henryscheintechcental.com

©2011 Henry schein inc. All rights reserved. Henry schein, the ‘s’ logo and dentrix are all trademarks or registered trademarks of Henry schein inc.  A-dmtC-Q311



[My Business Challenge]

Insurance

claims are

often delayed

or denied

We can show you how to 
code correctly
for increased
reimbursement

that adds to your bottom line

• Implement review process 
for coding reports 

• Use missing codes to 
identify potential areas
of practice growth 

• Maximize legal 
insurance reimbursement

To discuss coding
or other practice-enhancing solutions:

Contact your local Henry Schein 
Sales Consultant 
or call 1-800-372-4346 (PROMPT 6)
Visit www.HenryScheinWeDoThat.com

CODING Ronnie Klein
Henry Schein Sales Consultant

“When analyzing customersʼ coding,
I review their coding reports for

areas of improvement such as
missing codes that should

appear more frequently
(e.g. cavity varnish) and

areas of potential growth
for the practice (e.g. billing
lots of post and cores, the

office should consider
performing endo). 

After this analysis, 
my customers usually

see a 10-15% increase
in their gross income.”

www.HenryScheinWeDoThat.com

CODING   HR   MARKETING   NEW PATIENTS   OSHA   OVERHEAD REDUCTION    PERIODONTAL MANAGEMENT

PRACTICE ANALYSIS     RECARE    SOCIAL MEDIA   TEAM HARMONY   TRANSITION PLANNING
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inSTAnT
MESSAging 
In tHe Dental oFFIce

Jay wooD

Product Marketing Manager   

roger gagon 

Senior editor
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the users on myVoice voted. With nearly 2000 votes, the 
most requested new feature for Dentrix is instant messaging. 

it’s not surprising that so many Dentrix users voted for this 
feature. Dental offices are a hive of constant activity with a 
steady stream of messages between staff and clinicians. the 
front office staff are often busy checking patients in and out, 
filling out paperwork, and mailing lab work. And in the middle 
of all of that, they have to drop everything and find the dentist 
to deliver a message, which can impede customer service and 
other important office work.

Dentrix customers have a better option. here’s a preview 
of Dentrix Dentalink, an intra-office instant messaging system 
created specifically for dental offices. Dentalink is now avail-
able to any dental office on Dentrix G4 Productivity Pack 8. it 
can be deployed on computers throughout the office with the 
help of the eSync 3.1.5 Plug-in manager.

Dentalink lets users send and receive text-based 
messages. receivers are notified of new messages through a 
pop-up message bubble on the computer screen (Figure 1) 
and a subtle tone through the computer speakers, allowing 
them to take note of the message with little or no disruption 
to patient care.

Dentalink messages are sent to specific computers where 
the intended message recipient may be currently working. Using 
Dentalink, each computer in the office can be named with a 
readily identifiable name like “Front Desk,” “operatory 1,” 
or “operatory 2.” When Dentalink is open, the computer name 
appears in the Dentalink title bar, and the names of each computer 
with Dentalink installed display in a contacts list (Figure 2). 

a preview of Dentrix Dentalink, the 
new intra-office instant messaging tool 
created specifically for dental offices.
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And if staff members aren’t sure where the intended recip-
ient is working at the moment, they can use the Send Message 
to all option, which sends the message to all computers in the 
office. this option makes it easy to communicate the necessary 
information without having to worry about where the intended 
recipient may be in the office.

With such a powerful broadcast feature, some users may 
be concerned about the potential for accidental disclosure 
of private health information. the good news is there is no 

way for messages to accidentally go beyond an office’s own 
private network. Dentalink doesn’t communicate with other 
instant messaging systems, and messages are never routed 
over the internet.

Dentalink makes it easy for users to send routine commu-
nications using a feature called Quick messages. Quick 
messages are short messages you set up in advance that you 

can quickly select and send whenever you want (Figure 3). You 
can create as many Quick messages as you like. each computer 
can be configured with its own unique set of Quick messages 
so users don’t have to scroll through a long list of irrelevant 
messages to find the one they want. For example, you may 
want the Quick message “Your next patient is ready” to be 
available only from the Front office computer. 

Setting Up Dentalink
Dentalink is an eSync plug-in and is available with eSync 

3.1.5. For information about obtaining eSync 3.1.5 and 
Dentalink, see the “Downloading and installing eSync and 
Dentalink” sidebar.

Before you begin using Dentalink, you need to set it up. to 
access the Dentalink settings, with Dentalink open, click the 
Settings icon in the top-right of the Dentalink window.

  

 the eSync Settings page appears with the Dentalink 
Settings options displayed (Figure 4). here you can edit your 
Workstation name, create and manage Quick messages, and 
change the notification Display Length. After making changes, 
click Save in the bottom-right corner.

Sending Messages
A communication between you and a selected Dentalink 

contact is called a “conversation.” When you send your first 
message to a contact, you begin a conversation. During 
the conversation, you can reply to messages and view the 
messages you receive. When you are finished with the conver-
sation, you can end the conversation, and Dentalink removes 
all messages in that conversation from the Conversation Log.  

to select a contact and begin a conversation, click the 
contacts bar in the Dentalink window. each contact in the 
list is displayed with a colored icon to indicate its online  or 
offline status. the Contacts List is sorted alphabetically by 

Figure 1 Dentalink messages appear as pop-up messages 
on the screen.

Figure 2 messages can be sent to available computers in 
the Contacts list.

Figure 3 each computer can be configured with 
ready-to-use “Quick messages.”

12 | www.Dentrix.com/Magazine
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With Dentalink’s flexible, easy-to-use 
messaging tools, your office can deliver 
messages quickly and privately.

contact name, with online contacts listed before offline 
contacts. You can begin conversations only with contacts that 
are “online” (have Dentalink open). 

to begin a conversation, click the online contact with whom 
you want to converse and type a message in the Chat Box, or 
click the quick Message button and select a message from a list 
of Quick messages that you have added. When you’re ready to 
send your message, click Send or press enter. the system sends 
your message and posts the sent message to the Conversation 
Log. each message is identified by its sender and time. 

Receiving Messages
When Dentalink is open and an incoming message from an 

active conversation arrives, a tone sounds and the message 
appears in the Conversation Log just below the previous 
message.  in Figure 5, notice that the operatory 2 message 

(now active) appears just below the Front Desk message.
While in the active conversation, if you receive a message 

from another conversation, a tone sounds, a message bubble 
appears, and the Dentalink icon in the notification area 
changes to yellow so you know you have an unread message. 
in Figure 5, notice that when a new message was received 
from Dr. Jones, a new conversation bar was added for “Dr. 
Jones,” and the yellow icon appears in the conversation bar 
and in the notification area. 

Conversation bars let you manage multiple conversations 
at once. When you are finished with a conversation, you can 
either leave it opened for future use, or you can end it by 
clicking the x on the right side of the conversation bar. once 
a conversation is ended, its Conversation Log is cleared, and 
the conversation bar is removed from the Dentalink window’s 
Conversations Log. 

With Dentrix Dentalink’s flexible, easy-to-use messaging 
tools, your office can deliver messages quickly and privately. 
For more information about Dentrix Dentalink, visit  
www.dentrix.com/dentalink.   

Figure 5 Conversation bars are used to keep track of 
multiple Dentalink conversations.

if your office is on Dentrix G4 Productivity Pack 8 
and would like to start using Dentalink, you will 
need to download and install eSync 3.1.5 at www.
dentrix.com/products/eservices/esync. Under 
Documentation, click the eSync 3.1.5 Installation 
guide link to download the installation instruc-
tions. then click the Download eSync link and 
follow the instructions to download and install 
eSync 3.1.5.

eSync provides a Plug-in manager, and Dentalink 
is one of the available plug-ins that is installed 
with eSync. After you install eSync and the 
Dentalink plug-in, Dentalink opens automatically 
each time you start your computer. When 
Dentalink is open, a Dentalink icon appears in the 
notification area of the Windows taskbar. to open 
Dentalink when it is closed, click the Dentalink 
icon in the notification area.  

Downloading and Installing 
eSync and Dentalink

Figure 4 Configure Dentalink settings in the eSync Settings window.
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Thrive
    with Dentrix training by

Sean eyring 
Contributing eDitor 

Is it acceptable for your dentist to complete his/her degree but not keep abreast of the latest studies, developments, 

or changes in the industry? Is it OK for your office manager, who successfully manages the practice, to simply 

keep up the good work, even if more efficient methods, processes, or technology are readily available? Is it good 

enough to think, “If it’s not broken, why fix it?” The answer to these questions is, of course, “No.”

So what is the answer? instead of just carrying on with 
business as usual, you can invest in professional development 
and on-going training , which will help you, your team, and your 
practice thrive.

Professional development and on-going training are crucial 
for the employees and staff of any organization, and your 
dental practice is no exception. in her article titled “the #1 
reason new Practices Struggle: training” in the Winter 2010 
issue of the new Dentist magazine, Sally mcKenzie, Ceo of 
mcKenzie management, said, “the single biggest contributor 
to inefficiency and mismanagement in a new practice is a 
poorly trained team. if you want your staff members to succeed 
at their jobs and you want to have a more efficient, profitable 
practice, you need to make sure everyone in the practice has 
had adequate training by a professional.”

Sally continues, “At a minimum, every new employee 
should receive professional training on the computer practice 
management system, which is the central nervous system of the 
practice.” Because this is so important, Dentrix offers several 
different training options in order to meet the needs of busy 
dental practices like yours. 

Dentrix offers several training options that accommodate 
the needs of different practices as well as the learning styles 
of different learners. Whether you are a self-starter and like 
to discover new information at your own pace or you prefer 
receiving training in a group setting where you can learn from 
the questions and experiences of others, you can find a training 
option that will work for you. 

On-Demand Training
there is a wealth of information on how to use Dentrix that 

you can access 24 hours a day, 7 days a week, and 365 days a 
year— when you need it. the Dentrix resource Center, located 
at www.dentrix.com/resource-center, provides essential Dentrix 
learning resources for your entire dental office. new team 
members can learn Dentrix basics with on-demand tutorials. 
experienced staff can enhance their Dentrix knowledge and 
skills with webinar recordings, user’s guides, and searchable 
knowledgebase articles.

the Dentrix knowledgebase, found in the resource Center, 
is made up of nearly 12,000 individual articles written by the 
Dentrix Customer Support team. Knowledgebase articles are 
searchable by keyword, which makes it easy for you to find the 
information you’re looking for. Articles are updated and new 
information is added to the knowledgebase every week.

in the resource Center you’ll find on-demand training which 
includes recorded webinars, interactive tutorials spanning 
a wide range of topics, and downloadable product manuals, 

The bottom line is that when you provide 
training for your team, along with the tools 
they need to do their jobs, they thrive—and 
so does your practice.
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including user’s guides and installation guides for current and 
prior versions of Dentrix.

one popular type of on-demand training offered in the 
resource Center is tutorials. tutorials are short video presenta-
tions on how to access Dentrix modules, perform specific tasks 
within Dentrix, and use Dentrix to increase your practice’s 
profitability. tutorials explain fundamental concepts and guide 
you through hands-on practice exercises. 

on-demand training also includes webinar recordings of 
Dentrix and eServices training webinars. Live webinars are 
recorded and categorized by topic, and you can access them 
at any time following the live event. When viewing recorded 
webinars, you have access to the tip sheets 
that were provided during the live event.

Access to the on-demand training topics 
in the resource Center is included with your 
Dentrix Customer Service Plan. if you don’t 
have a customer service plan, you can enter 
the resource Center as a guest and access a 
limited selection of knowledgebase content, 
webinar recordings and tutorials. Guests do, 
however, have full access to downloadable 
Dentrix and eServices manuals in PDF format.

to log into the Dentrix resource Center, 
go to www.dentrix.com/resource-center and 
enter your customer ID number and office 
zIP code, or enter as a guest. once logged in, 
use the tabs at the top of the screen to navi-
gate to the type of content you want to view. 

webinars
Webinars are scheduled, live events, presented via the 

internet that focus on a variety of Dentrix and eServices topics. 
During a webinar, you can see the presenter’s computer screen 
as he or she demonstrates how to complete tasks, and you can 
ask the presenter questions, receive answers, and learn from the 
questions being asked by other attendees. 

Webinars generally run between 30 and 60 minutes and are 
excellent resources for learning tips that will improve the efficiency 
and productivity of your office. While many webinars are free for all 
viewers, some webinars require a Dentrix Customer Service Plan. 

Dentrix offers three different types of webinars.

•	 Solutions	Webinars	show	you	how	Dentrix	solutions	resolve	
critical practice management challenges. these webinars are 
recommended for current and prospective Dentrix users. 

•	 eServices	Training	Webinars	help	you	learn	how	to	start	using	
Dentrix eServices such as eCentral, eClaims and Attachments, 
QuickBill, and more. these webinars are recommended for 
current Dentrix users who are learning to use eServices.  

•	 Dentrix	Training	Webinars	teach	you	how	to	use	popular	
Dentrix features better. these webinars are recommended for 
current Dentrix users wanting to keep their Dentrix knowledge 
and skills up to date.

to register for a webinar, visit www.dentrix.com/webinars 
and click the register button for the type of webinar you want 
to attend.  A list of the upcoming webinars will be displayed.  
Click the title of the webinar you are interested in and follow 
the on-screen prompts. A confirmation email, along with login 
information for your registered webinars, will be sent to you prior 
to the live event.

Seminars and workshops
Seminars and workshops are training opportunities that 

take place outside of the dental office. Both options give you 
a chance to learn more about Dentrix in an environment that 

is free from the office duties, phone calls, and interruptions 
that can make learning difficult. Because of the group dynamic 
of seminars and workshops, you can learn from discussions 
with other attendees about the kinds of challenges they are 
facing and how they are using Dentrix to increase the efficiency, 
productivity, and profitability of their practice.

Seminars are generally half-day presentations in which you 
learn about new features, get tips for making your practice 
more profitable, and discover the benefits of having a Dentrix 
Customer Service Plan. Seminars are taught by certified trainers 
who can answer your questions, offer advice, and share their 
experiences with you. As a seminar attendee, you’ll receive 
handouts with tips for using Dentrix that you can take back to the 
office and use as reference when performing tasks and routines.

typically held as one- or two-day events, workshops are 
taught by Dentrix Certified trainers and provide a hands-on 
training experience in a computer lab, allowing you to practice 
the skills and methods being taught during the class without 
having to worry about making mistakes or deleting genuine 
patient information. When attending a workshop, you receive a 
study manual with step-by-step instructions for how to perform 
the tasks taught during the workshop, exercises to perform 
during the workshop, and questions designed to prompt class 
discussion. these manuals are yours to keep and can be used as 
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a reference once the workshop has ended and you have returned 
to the office to begin implementing what you have learned.

For more information about Dentrix seminars and workshops, 
visit either www.dentrix.com/insightseminar or www.dentrix.com/
workshops  to find dates and locations, course descriptions and 
registration options.

In-Office Training
A popular training option is to have a Dentrix Certified trainer 

visit your office for training sessions. in-office training can be 
purchased in four-hour increments. You can use in-office training 
to train individual staff members, the whole practice, or smaller 
subsets of the practice (for example, the clinical staff). 

the biggest benefit of in-office training is the personalized 
attention and training you receive. You are able to interact 
one-on-one with the trainer, ask questions, and get hands-on 
practice using your own patient database. the trainer can help 
you learn to use Dentrix to meet your office’s particular needs 
and challenges, interpret your practice’s data, and implement 
routines based on how you prefer to handle patients, insurance, 
and treatment.

most offices schedule in-office training when they first install 
Dentrix. Staff changes or interest in special topics can trigger 
the need for additional in-office training after the initial instal-
lation. Sample topics for in-office training include managing 
patient information, schedule management, insurance manage-
ment, office routines, and charting, as well as other topics based 
on the practice’s needs. 

While not required, it is highly recommended that you close 
your practice on the day(s) of training to prevent distractions 
(for example, phone calls, patients coming in, etc.). if closing 
the practice for training is not possible, then the team members 

being trained should be given a private, dedicated space so they 
can focus on the training without interruptions from the daily 
business going on in the office.

to purchase in-office training, coordinate with a local trainer 
you already know, call 1-800-336-8749, or send an email to 
systemsimplementation@henryschein.com. 

Coaching
once you have learned how to use Dentrix for essential office 

tasks, you can receive profitability coaching to help you track 
key performance indicators and learn how to use Dentrix and 
eServices to increase the profitability of your practice. Coaching 
sessions happen over the phone, use a remote internet connection 
to provide a teaching environment using your computers and your 
patient data, and provide opportunities to ask questions and talk 
through examples that relate to your practice’s unique situation. 

Profitability coaching helps you understand the business 
of dentistry. For example, coaching does not focus on  how 
to “do” perio exams, but instead it focuses on how to compare 
the production amount of the perio exams with the amount of 
other work being done in the operatories, and how these totals 
measure up to the overall production in the office. however, 
coaching is not consulting; coaches will not make business 
decisions for you, but they will teach you how to use Dentrix to 
recognize opportunities for improvement, review your progress, 
and show you tools that can help your practice. 

to learn more about Dentrix profitability coaching, visit www.
dentrix.com/coaching  and request more information via the 
form provided, or visit estore.dentrix.com, select Dentrix >  
Services > training and coaching > coaching (Profitability) 
and select a coaching option to fit your practice’s needs.

ongoing professional development and training for the 
entire staff, both front office and clinical, is critical to the success 
of any practice. Dentrix offers a wide range of training options 
designed to fit the needs of practices and individuals wanting to 
improve their skills, so explore the training options that interest 
you, decide which options are best for your team, and start 
learning today. the bottom line is that when you provide training 
for your team , along with the tools they need to do their jobs, 
they thrive—and so does your practice.   

Professional development and on-going 
training are crucial for the employees and 
staff of any organization, and your dental 
practice is no exception.
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WHICH TrAInIng OPTIOnS ArE BEST fOr ME AnD My TEAM?

On-DemanD Webinars seminars WOrkshOps in-Office cOaching

self-paced X

With an instructor X X X X X

hands-on practice with software X X X

Opportunity to ask questions X X X X X

One-on-one X X

group setting X X X

face-to-face X X X

Online or over-the-phone X X X

personalized based on needs X X

available in the office X X X X

available outside of the office X X X X

for staff with no Dentrix experience X X X

earn ce credits X

included with Dentrix customer 
service plan

X X

Your office. our experts.
Get more out of your Dentrix investment with customized in-office training.

Whether you’re looking for a refresher on Dentrix basics or a 
deep dive into advanced features, Dentrix In-Office Training is 
a customizable, cost-effective way to train your team.

Dentrix In-Office Training delivers:

•	Customization. Work with a Dentrix Trainer to focus on 
the needs of your practice. 

•	Flexibility. Schedule training when it works for you, your 
team and your patients. 

•	Value. Train up to six members of your team without 
closing or leaving the office. 

•	Expertise. Learn from a Dentrix certified training 
professional.

©2011 Henry Schein Inc. All rights reserved. Henry Schein, Dentrix and the ‘S’ logo are trademarks or registered trademarks of Henry Schein Inc.  A-DTXTN-Q311

Get more information and schedule a training today! 
Contact us at 1-800-336-8749 or partnersinpractice@henryschein.com.



Scheduling the Perfect Day
Learn how to use Perfect Day Scheduling to help you achieve your profitability 
goals and make your schedule more efficient at the same time.

 May Wescott | Contributing editor 
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w   ould you tell me, please, which 
way I ought to go from here?’ 
`That depends a good deal on 

where you want to get to,’ said the Cat. 
`I don’t much care where--’ said Alice. 
`Then it doesn’t matter which way you 
go,’ said the Cat.   (Alice’s Adventures in 
Wonderland, Lewis Carroll)

All too often dental offices take Alice’s 
approach when it comes to scheduling 
patients. instead of setting clearly 
defined goals to work toward, offices 
schedule patients willy-nilly, looking 
for the first available appointment time 
without considering the need to build a 
profitable and efficient day. the result is a 
busy, stressful day that may not get them 
closer to their vision of success. 

Scheduling for production is a 
different approach. it creates a clear 
map to your profitability goals. When 
you schedule for production, you reserve 
time in your appointment book for 
certain types of procedures. As Cathy 
Jameson, Ceo of Jameson management, 
puts it in her Scheduling for Productivity, 
Profitability, And Stress Control webinar, 
“Scheduling for production doesn’t mean 
that all you’re interested in is money. 
not at all. it means that in equalizing the 
productivity of your days you will have 
smoother days, less stress and will end up 
with a great month.”

the Perfect Day Scheduling feature 
makes it easy for you to schedule 
for production. With Perfect Day 
Scheduling, you can set up “time  
blocks” to reserve space for specific 

procedures in your Appointment Book 
(Figure 1). the system reminds you that 
the time is reserved for those procedures 
both visually and with alerts. 

Creating appointment Types
to begin, decide what types of 

appointments you want to block time for 
in your Appointment Book. For example, 
in his Set Your Practice on Fire webinar, 
Dr. roger Levin recommended that you 
set up your schedule to book “major 
production” services in the morning with 
the goal of achieving 60 – 65% of your 

daily production in that block. Similarly, 
in her productivity webinar, Cathy 
Jameson suggested that you pre-block 
for “primary procedures” and then 
work in your “secondary” and “tertiary” 
procedures around that block. (these 
and other profitability topics can be 
viewed in the Dentrix resource Center.)

After you’ve decided on your 
appointment types, you’ll need to add 
them to Dentrix so that you have a list to 
choose from when creating time blocks 
and appointments. From the office 
Manager, click Maintenance > Practice 

Patient information & Schedul ing

Figure 1 With Perfect Day Scheduling, you can reserve appointment time blocks 
for specific types of procedures, making your days more efficient and profitable.

Scheduling for production 
creates a clear map to your 
profitability goals.
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Setup > Definitions. Click the Definition 
type drop-down menu and select 
appointment types (Figure 2). Add  
new types or change the existing types 
as necessary.

Creating Time Blocks
once you’ve set up the appointment 

types you want, you’re ready to begin 
blocking time in the Appointment Book. 
Blocks are set up by provider. From the 
Appointment Book menu, click Setup >  
Provider Setup. Select the provider 
whose blocks you want to set up and click 
Setup. From the Provider Setup dialog 
box, click the add button under Set 
time Blocks. the Block Settings dialog 
box appears (Figure 3). You should assign 
a name, a color, days of the week, time 
range, operatory, and appointment type 
to each block. repeat this process for all 
providers and blocks that you want to use 
in your schedule.

enabling Perfect Day Scheduling
As a final step, you need to turn 

on Perfect Day Scheduling. in the 
Appointment Book, click options > 
Perfect Day Scheduling. You should now 
see the time blocks you created in the 
operatories of your Appointment Book. 
this serves as a visual cue to remind 
you that these times are blocked for the 
production types you set up.

Scheduling an appointment
to schedule an appointment in a time 

block, double-click the start time as you 
would to schedule any appointment. 
enter the necessary appointment infor-
mation. Before clicking ok to save the 

appointment, click the type drop-down 
menu and select the appointment type 
for this appointment. the appointment 
type should match the block type you’re 
scheduling. (See sidebar, “Attaching 
Procedures to Appointment types”.)

if you forget to assign the appoint-
ment type or you try to schedule an 
appointment for a different type of 
production, a warning message will 
appear. You can choose to return to the 
Appointment information dialog box to 
assign the proper type or you can choose 
to schedule the appointment anyway.
(Keep in mind, there will be times where 
you’ll need to schedule an appointment 
in a time reserved for something else and 

Dentrix allows you to over ride the block 
for those situations.)

By using the Perfect Day Scheduling 
feature, you take the guesswork out 
of scheduling and put your office on 
track to have a more profitable and less 
stressful month.   

learn More
To learn more about using Perfect Day 

Scheduling, see the Perfect Day Scheduling 
Overview topic in the Dentrix Help. You can 
also visit the Dentrix Resource Center to view 
the Perfect Day Scheduling webinar recording.  
See “How to Learn More” on page 3 for 
instructions on accessing these resources.

   

Figure 2 Use the Practice Definitions dialog box in the office manager to customize 
the types of appointments you want to block time for.

Figure 3 Assign colors, operatories, 
types, days, and times for your blocks.

You can save a step when 
scheduling for a blocked type of 
appointment by linking appoint-
ment types to procedure codes. 
When you select a linked code 
as the reason for the appoint-
ment, the appointment type 
will automatically appear in the 
type field of the Appointment 
information dialog box, saving 
you from manually selecting the 
appointment type in order to 
schedule the appointment in a 
time block. 

to associate appointment 
types with procedure codes, 
from the office Manager, 
click Maintenance > Practice 
Setup > Procedure code 
Setup. Select the desired 
procedure code and click edit. 
the Procedure code editor 
dialog box appears. Click 
the Appointment type drop-
down menu and select the 
appropriate appointment type. 
Click Save.

attaching 
Procedures to 
appointment 
types
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Several years ago, my physician 
moved his practice into a former 
bank building. his new office still 

contained the bank vault, so he used 
it to store the hundreds of file folders 
containing his patients’ charts. While 
the charts were obviously secure in the 
vault, i’m sure that creating, retrieving, 
updating, and re-filing them was neither 
fast nor easy. the Dentrix Patient Chart 
(Figure 1) makes creating, backing up, 
retrieving, modifying, and re-filing your 
patient charts quick and easy. Paper 
charts are time consuming and require 
a lot of space. they are also difficult to 
track, update, or duplicate and can be 
misplaced, falsified, or destroyed more 
easily than we sometimes imagine. 
transitioning from paper to digital 
patient charts just makes sense for your 
patients and your business.

Procedure Buttons and Codes
By default, Dentrix provides you with 

24 procedure buttons that you can use 
to quickly post procedures to a patient’s 
chart. however, you’re not limited 
to those 24 buttons. You can add an 
unlimited number of procedure buttons 
and customize them for your practice. 
And since the procedure button settings 
are computer specific, you can further 
customize them according to the type of 
work performed in a particular operatory.

You can also use the Procedure 
Codes list to post procedures. this list is 
very helpful when you need to post more 
than one procedure or if you haven’t set 

up a procedure button. however, since 
the list contains all of the ADA procedure 
codes, you can use the office manager 
to hide codes that you never use. to hide 
a code, from the Maintenance menu in 
the office manager, point to Practice 
Setup, and then click Procedure code 
Setup. Select a category and the proce-
dure that you want to hide, click edit, 
and clear the Show in chart option.

entering Treatment
With the Patient Chart, charting 

treatment couldn’t be easier. Using just 
your mouse, in the Graphic Chart, select 
the tooth or teeth you want to treat. Click 
the appropriate procedure button or 
procedure code, and then click the Post 
button in the Procedure Codes toolbar.

Assign a status by clicking the 
existing other, existing, treatment 

Plan, or completed buttons. if the 
procedure you selected requires 
additional information, such as surfaces, 
select them from the Select Surface 
dialog box and click ok (Figure 2). 
Dentrix adds the procedure to the 
Graphic Chart and the Progress notes.

auto-State
the Auto-State button can save 

you time when you create a treatment 
plan for current patients or when you 
examine new patients. For example, you 
might begin examining a new patient 
by charting existing treatment and 
conditions. 

First, click the Auto-State button and 
then click the existing (ex) status button.

 
From the Graphic Chart, select 

the teeth you want to chart, click the 
appropriate procedure buttons, and then 

Going Digital with the Dentrix Patient Chart
transitioning from paper to digital patient charts makes sense for your patients and your business.

 gary Frazier | Contributing editor

Pat ient Care

Figure 1 the Patient Chart.

The Dentrix Patient Chart 
makes creating, backing 
up, retrieving, modifying, 
and re-filing your patient 
charts quick and easy.
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click the Post button on the Procedure 
Codes toolbar. Dentrix enters the 
procedure and the “ex” status in the 
Graphic Chart and in the Progress notes. 
You don’t have to click the existing status 
button for each procedure. Because you 
clicked both the existing and Auto-
State buttons, Dentrix remembers that 
you’re charting existing treatment and it 
automatically assigns the “ex” status to 
every procedure.

After adding all the existing treat-
ment, you can click the treatment Plan 
button and enter all of the treatment-
planned procedures. When finished, you 
can then click the Completed button 
and enter any procedures you complete 
during the current visit.

Dentrix remembers the selected 
status even after you finish charting, so 
it’s a good practice to click the Auto-
State button again to turn it off after you 
finish charting.

Clinical Notes
A big part of your job is documenting 

treatment. rather than spending time 
typing your notes after hours or between 
patients, let the Patient Chart do the 
typing for you. Click the clinical notes 
tab, and from the toolbar, click the new 
Clinical note button.

 
Select a category, double-click the 

template you want to use, and then 
click the appropriate responses to the 
prompts associated with the template. 
Dentrix records your responses and 
creates the Clinical note for you.

Printing
With Dentrix you can create and 

print a custom view of the Patient Chart 
for your patients. From the File menu 

in the Patient Chart, point to Print, 
and then click Patient chart. From the 
Print Patient chart dialog box, select a 
report option, and then select whether 
to print the patient’s Progress notes, 
today’s work and treatment Plan, only 
treatment Plan, or only today’s work. 
next, select whether to hide the patient’s 
personal information and whether to 
print the Graphic Chart or include a 
legend. to create and name a custom 
view, click Save options and type the 
patient’s name (Figure 3).

Whether your practice consists of a 
single chair or several chairs and multiple 
providers, using the Patient Chart will 
make your practice more efficient and 
your records more accurate and secure, 
ultimately saving you time and money.  

learn More
To learn more about the Patient Chart, 

visit the Dentrix Resource Center and view 
the Charting and Editing Treatment tutorial. 
You can also see the Patient Chart topics in 
the Dentrix Help.  See “How to Learn More” 
on page 3 for instructions on accessing 
these resources. 

Figure 2 the Select Surface dialog box.

Figure 3 the Print Patient chart 
dialog box.
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New Tools to 
Make Practices
More Focused, Efficient 

and Productive

New Features INclude:

New Daily Huddle Reports

Dentrix Launcher

Enhanced Pinboard 
Capabilities

Letter Merge Add-in 
for Microsoft Word

Improved Patient Records 
Management Tools

Prescription Refill Button

Secure Instant Messaging
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I magine this scenario: Brent Crosby 
came to your office a few weeks ago 
for a filling. You completed his treat-

ment and submitted a claim for a resin 
one-surface with a $115 charge. When you 
received the check from the insurance 
company, it was only for $100 and included 
a letter that explained that $100 was the 
usual, customary, and reasonable fee (UCr 
fee) for that procedure.

if your practice accepts dental insur-
ance, this has no doubt happened to 
you. UCr fees are the maximum amount 
insurance companies will pay for certain 
procedures, so regardless of your prac-
tice’s fee for the procedure, you won’t get 
more than the UCr fee from the insur-
ance company. these fees can vary by 
procedure and by insurance company, so 
it can be hard to anticipate what the UCr 
fee will be. 

oftentimes you don’t know about an 
insurance company’s UCr fee until you 
submit a claim and receive a payment 

that is less than what you charged on the 
claim. What do you do in that situation? 
most often you just have to write off the 
difference. Luckily, Dentrix makes it easy 
to post a write-off adjustment to insur-
ance claim payments.

entering write-off adjustments
to enter a write-off adjustment when 

you post a payment to a claim, from the 
Ledger, select the patient and open 
the insurance claim for which you want 
to enter a payment. in the insurance 
claim, from the enter Payment menu, 
select total Payment only. the total 
Insurance Payment dialog box appears 
(Figure 1).

enter the payment information, 
such as the date, check number, bank/

branch number, and type of payment. 
Under Provider amounts, select the 
provider to whom you want to apply the 
payment. Click edit to enter the claim 
total, or click add to add a payment for a 
new provider. Under enter adjustment, 
select write-off (-) from the list. 

enter the dollar amount you want to 
write off for the claim. in Brent’s case, 
the write-off amount would be $15. From 
the type list, select the adjustment type 
you want to use. Click ok to post the 
write-off. 

if you want to track write-offs by 
insurance company, you can set up a 
specific write-off type for each insurance 
company. that way, when you run the 
Adjustment Summary from the Practice 
Analysis in the office manager, you can 

Managing Insurance Payment adjustments
Dentrix makes it easy to post write-off and refund adjustments when you receive  
insurance payments. 

 Erin Brisk | Senior editor

Your money

Figure 1 You can enter write-off or refund adjustments at the same time you enter 
payments for insurance claims so you don’t have to add the adjustments later.

oftentimes you don’t 
know about an insurance 
company’s uCr fee until 
you submit a claim and 
receive a payment that is 
less than what you charged 
on the claim. Luckily, 
Dentrix makes it  
easy to post a write-off 
adjustment to include 
claim payments.
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track how much you are writing off for 
each insurance company.

entering Refund adjustments
in some cases patients will have 

paid their estimated balance before you 
receive the insurance payment, and the 
insurance payment may have covered 
more than you expected, so you need to 
enter a refund adjustment for the patient. 
if you have Dentrix G4 Productivity Pack 8 
(or a later version of Dentrix), you can also 
enter refund adjustments when you post 
a payment to a claim.

to enter refund adjustments on the 
insurance payment, follow the previous 
steps to enter a write-off adjustment. You 
just have to select refund from the enter 
adjustment list instead of write-off.

entering insurance adjustments from 
the total Insurance Payment dialog box 
in the insurance claim saves you from 
having to enter the insurance payment 
and then enter a separate adjustment. it 
also makes it easier for you to calculate 
the amount that needs to be adjusted, so 
it makes it easier to work with insurance 
payments.   

learn More
To learn more about adjustments in Dentrix, 

see these topics in the Dentrix Help: Adjusting 
Insurance Payments Automatically and Setting 
Up Automatic Insurance Payment Adjustments. 
You can also visit the Dentrix Resource Center 
and view knowledgebase article 49578. See 
“How to Learn More” on page 3 for instructions 
on accessing these resources.

Figure 2 You can specify insurance 
adjustment defaults to make it even 
faster and easier to enter adjustments 
to insurance payments.

if you have Dentrix G4 
Productivity Pack 8 (or a later 
version of Dentrix), you can 
make entering adjustments 
even easier by specifying 
default adjustment types for 
write-offs and refunds. then, 
when you split the claim and are 
left with a write-off or refund 
adjustment, you don’t have to 
select the adjustment type; the 
type you use most often will 
already be selected for you. 

to specify the default write-off 
and refund insurance adjust-
ment types, in the Ledger, from 
the File menu, click Insurance 
Payment Setup. the Insurance 
Payment Setup dialog box 
appears (Figure 2). Under 
Insurance adjustment Setup, 
click the search buttons to 
open the Select adjustment 
type dialog box and select the 
default insurance write-off and 
refund adjustment types. 

if you want to have Dentrix 
automatically calculate adjust-
ments when you enter insurance 
payments and save you the 
step of manually calculating the 
adjustment amount, check the 
enable automatic adjustments 
for Insurance Payments check 
box. if you want Dentrix to 
automatically post adjustments 
to replace negative payment 
amounts when the insurance 
company overpays, check the 
auto-post refund adjustments 
to replace negative payments 
check box. Click ok to save the 
default adjustment types.

Specifying Default 
adjustment types

©2011 Henry Schein Inc. All rights reserved. Henry Schein, Dentrix, 
PowerPay, and the ‘S’ logo are trademarks or registered trademarks of 
Henry Schein Inc.  A-ESPPDTX-Q311
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I f you’re like me, you read and store 
books on an eBook reader, view and 
store important documents and 

e-mail messages on your computer, 
receive and pay your bills online, and 
even submit your taxes electronically.  

in an age when you can do so much 
with electronic media, you don’t need 
to store paper consent forms on shelves 
or in filing cabinets. Dentrix offers a 
paperless solution for filling out, signing, 
and storing consent forms that is easy 
to use, efficient, and secure. this article 
explores the benefits of using digital 
consent forms and then explains how 
to modify and use consent forms in the 
Dentrix treatment Planner.

The Benefits of Digital Consent Forms
implementing digital consent forms 

using the Dentrix treatment Planner 
module provides several benefits. From 
any computer in your office, patients can 
read and sign consent forms immediately 
after receiving treatment options. Anyone 

in the office can then access those 
consent forms from any computer. if you 
use electronic consent forms and back 
them up with a secure, offsite service 
like eBackUp, you can protect signed 
consent forms from accidental damage or 

loss. Furthermore, storing consent forms 
on your computer, instead of in filing 
cabinets and on shelves, gives your office 
a more modern, professional image. 

Modifying Consent Forms in 
the Treatment Planner

the Dentrix treatment Planner 
comes with the following default 
consent forms: Consent for Anesthesia, 
Consent for treatment, and Decline 
treatment Consent. You can modify a 
consent form as long as it is not already 
attached to a patient. (if it is attached 
to a patient, you’ll need to save the 
modified consent form with a new 
name.) With any patient selected in the 
treatment Planner, click the Settings bar 
to expand that section.  Under Setup 

consent Forms, select the form you 
want to modify, and then click edit to 
change that form.

Using Consent Forms in the  
Treatment Planner

to use a consent form in the 
treatment Planner, right-click the 
treatment plan case that requires a 
signed consent form, and then click 
consent Forms. in the Dentrix consent 
Forms dialog box (Figure 1), select the 
appropriate form type from the Select 
consent Form list box, and then click 
add to view the consent form (Figure 2). 
Acquire the required electronic signa-
tures using a pointing device, such as 
a mouse, touch-screen, or a supported 
signature pad (ePad or ePad ii). Click 
Save and then close.

Retrieving Signed Consent Forms 
You can view signed consent forms 

from any computer in your office. in 
the treatment Planner, right-click the 

Using Digital Consent Forms
Using digital consent forms in the Dentrix treatment Planner module is efficient,  
secure, and easy.

 gentry Winn | Contributing editor

Going Paperless

Figure 1 the Dentrix Consent Forms 
dialog box.

Storing consent forms on your computer, instead of in 
filing cabinets and on shelves, gives your office a more 
modern, professional image.
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treatment plan case with a signed 
consent form, and then click consent 
Forms. in the Dentrix consent Forms 
dialog box (Figure 1), under Form, 
double-click one of the forms listed.

if you want to have access to the 
consent form in another area of Dentrix, 
you can send a copy of the form to the 
Document Center by clicking Print 
(your default Windows printer must 
be the “Send to Dentrix Document 
Center” printer driver) and then 
attaching the PDF to the appropriate 
patient and/or provider.   

learn More
 To learn more about digital consent 

forms, see the Creating and Editing 
Consent Forms topic, and the Viewing and 
Editing Consent Forms for Cases topic, in 
the Dentrix Help. See “How to Learn More” 
on page 3 for instructions on accessing 
these resources.

Figure 2 Add a consent form to a treatment plan case and have the patient sign it.

nowadays, increasing numbers of dentists are 
discovering that they can save money and space, 
increase productivity, and share information faster  
and easier by implementing “paperless” solutions  
in their practices.

examples of paperless solutions include charting 
treatment and making clinical notes on the computer, 
sending e-mail and text message appointment 
reminders, capturing digital x-rays, submitting online 
lab prescriptions, verifying eligibilities on the web, and 
submitting electronic insurance claims to name just a few.

With the Uniform electronic transactions Act (UetA) 
and the electronic Signatures in Global and national 
Commerce Act (eSiGn), electronic contracts and 
electronic signatures have become legal and 
enforceable just like traditional paper contracts.  
For dental practices, this means a consent form 
signed electronically in your office is a legally 
binding document.

Additionally, a powerful motivator to go paperless 
has grown out of concern for the environment. 

Consider a few of the environmental impacts of using 
paper in our business:

•	 The	U.S.	pulp	and	paper	industry	is	the	second	
largest consumer of energy.

•	 56,000	gallons	of	oil	are	used	for	every	10	 
million pages.

•	More	than	400	million	ink	and	100	million	 
toner cartridges end up in landfills each year.

(Data Source: www.epa.gov)

the following websites provide valuable information 
regarding paperless solutions:

•	 ADA	-	For	information	about	ongoing	efforts	by	
the U.S. Department of health and human Services 
(hhS) to encourage the use of electronic health 
records (ehrs) or “paperless” solutions as part of 
the hiteCh Act, visit www.ada.org/5348.aspx.

•	 Dentrix	-	For	information	regarding	eligibility	for	
government incentives for implementing paperless 
solutions, visit www.dentrix.com/ehr.

growing Support for Paperless Solutions 
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You’ve heard about it. You’ve read 
about it. everyone else is doing 
it. You know what “it” is. “it” is 

social media! 
So why haven’t you jumped on that 

bandwagon like every other business? 
After all it’s free to use. it takes less than 
ten minutes to set up. Virtually anyone 
can do it. So what’s holding you back?

here are a few of the most common 
reasons why people aren’t using social 
media and why you should not let them 
hold you back. 

Facebook and Twitter won’t Really 
Help My Practice

this is the biggest misconception. 
Facebook and twitter can and will help 
your practice. 

think about the evolution of  
communication and getting the 
message out to others about busi-
nesses. For a long time it was word of 
mouth. Some practices used adver-
tising such as direct mail, radio, and 
print ads. most practices didn’t use 
traditional marketing because it was 
cost prohibitive and not necessarily 
popular among dental professionals. 
then the web came along, allowing 
people to learn about you in their 
own homes and at their request. this 
medium was and is two-dimensional. 
they were only allowed to view what 
you specifically displayed on your  
web page. 

now we are entering the next  
evolution in communication: social media. 
now people can learn about you from 
others, engage in open conversations 
with you, learn what others are saying, 
and so on. it’s all about creating an online 
conversation that helps people humanize 
you, your team, and your practice. A 
relationship is built online and made 

stronger through social media. And since 
dentistry is in the relationship business, 
you couldn’t ask for a stronger medium to 
get your message out to others. 

thanks to Facebook and twitter, 
people will actually remember your  
name now!

I’m Concerned People will Post  
Negative Comments about the 
Practice

Guess what?  Whether or not someone 
is posting negative comments about 
your practice on your Facebook page, 
that same person could be posting 
negative comments about your practice 
elsewhere on the web. if it happens on 
your Facebook page, at least you have a 
chance to respond. You are part of the 
conversation now. You get to put your 
best foot forward and reconcile with this 
person. And, if nothing else, you get to 
show others that you respond, care, and 
desire to meet people’s expectations. 

if you have multiple negative postings 
on your Facebook page, then this is also 
positive. it is alerting you to the fact that 

you need to improve internal systems such 
as scheduling, the new patient experience, 
or customer service. take the feedback 
and do something about it. then you can 
post to Facebook and twitter that you 
heard the concerns and you fixed them. 

now that’s turning lemons into 
lemonade, which would have never 
been possible without the conversation 
created through social media.

I Don’t Have Time to Do It
it is a bonus if you, the dentist, like 

to post and tweet. it’s a better way 
for you to connect with your patients. 
however, it’s not the end-all, be-all if you 
are not the one tweeting. most people 
use a trusted team member to oversee 
Facebook and/or twitter. 

Find someone on your team who 
is excited about the practice, likes to 
promote you, and is active in social media 
or is comfortable with the web. have this 
designated person report back to the 
team during your team meetings. this 
will energize your entire team and the 
consistent presence on social media will 
in turn energize your patient base.

I’m Concerned My Team will Play on 
Facebook or Twitter all Day

Abusing social media for personal 
gain isn’t any different than abusing the 
telephone, the web, email, or talking with 
colleagues throughout the day. All of it 
is necessary and all of it can be abused, 
taking time away from productive and 
valuable work time in the practice. 

institute a policy and allocate specific 
times in the day to be used to work on 
social media. Choose a team member 
who you can trust and who shares your 
vision for the practice to be responsible 
for the social media activity. monitor the 
progress being made. hold the team 
member accountable for activity.  

You can also use software like 
hootsuite to organize and make posts for 

Five Social Media Hurdles and  
How to Overcome Them
You’ve heard about it. You’ve read about it. everyone else is doing it. So what’s holding you back? 

 Misty Absher Clark | VP of Creative Services, Jameson management

Business of Dentistry

Social media is here to stay, and it is rapidly becoming one 
of the cornerstones to any good marketing plan. Jump in 
now. Practice, learn, and grow! Like any change, it will be 
uncomfortable at first, but then, with time and results, 
you’ll wonder why you didn’t try it sooner.
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the month automatically on designated 
days. then your team member is simply 
checking the site everyday for comments 
by patients who may need a reply. 

I Don’t Know what to Put on Facebook 
or Twitter

You are not alone. this is the biggest 
hurdle and obstacle for people. here 
is a good rule of thumb: 80% of your 
communications should be giving and 
20% should be selling the business. this 
means that 80% of your posts or tweets 
should be giving information such as 
quotes or inspirational thoughts, support 
of the local community, fun facts on 
dentistry, helpful tips and hints, personal 
information on the doctor or team (e.g. 
“We are excited to announce the birth 
of our hygienist’s son!”), or any other 
fun and interesting information. the 
remaining 20% is reserved for promoting 
a product such as tooth whitening or the 
need for perio therapy. 

the question is often asked, “how 
many posts/tweets do i need to make 
in a week?” on Facebook, you need to 
make between three and five posts each 
week. For twitter, you should be tweeting 
eight to ten times per week since the 

lifespan of a tweet is shorter than a post 
on Facebook. Photos are also a great 
addition and should be uploaded to your 
sites at least once a month. 

Social media is here to stay, and it 
is rapidly becoming one of the corner-
stones to any good marketing plan. You 
can choose to start with it now and grow 
as the medium grows. or you can wait, 
let it pass you by, and decide in a few 
years that you need to start. By then 
you’ll be playing catch up. Your practice 
will be using social media—either now 
or in five years. So why wait? Jump in 
now. Practice, learn, and grow! Like any 
change, it will be uncomfortable at first, 
but then, with time and results, you’ll 
wonder why you didn’t try it sooner.     

Misty Absher Clark is Vice President 
of Creative Services at Jameson. Receive 
guidance or coaching on how to put 
social media into place. Clark and a 
team of dental marketing coaches help 
practices like yours get a jump start on 
social media and work into ongoing, 
comprehensive marketing plans. Visit 
www.Jamesonmarketing.com  
today or call 877.369.5558 or email  
info@jamesonmanagement.com.
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A progressive practice depends on Dentrix 
and TechCentral to improve patient care, 
boost profits, and free up resources for 
humanitarian service. 

Since its establishment in 1977, Dr. rick hammel’s Clay 

Center Family Dental Care has been dedicated to high- 

quality dentistry based on a set of core values that 

govern his life and dental practice. Working alongside rick is 

his wife of 37 years, nancy. together they have built a practice 

that includes two full-time dentists and a nine-person support 

team that provides a complete range of preventative, clinical, 

and cosmetic dental services in a state-of-the-art 3,600 

square foot facility. Because of their core values, the hammels 

and their team are also deeply committed to giving back to 

their community through the Clay Center Dental mission, a 

charitable organization that provides free dental services to 

local people, as well as to the Belize mission Project.

FinDinG the riGht PArtner

throughout its long history, Clay Center Family Dental 

Care has been a strong proponent of using technology to 

create a more efficient, responsive, and patient-focused prac-

tice. “We were among the first dental offices in the state to 

install a networked computer system to manage our patient 

records in the late 1980s,” recalled office manager nancy 

hammel. “Back then, we hired a high school teacher who did 

a little it work on the side to install and support our system. 

there were constant problems, because although he had a 

decent technology background, he had zero experience with 

dental software or the dental industry.”

Although the hammels quickly moved to a more profes-

sional full-time general technology provider, similar problems 

persisted until shortly after they installed their first digital 

radiography system in the mid-1990s. “once again, we were 

among the first to adopt this kind of technology,” said nancy 

hammel. “the general it provider we were using at the time 

could not make our new digital imaging system work with 

our Dentrix practice management software, and we were 

frankly starting to panic. then, someone connected us with 

the experts at henry Schein techCentral. they came into our 

office, fixed the problem, and literally had us up and running 

in five minutes. that experience taught us the tremendous 

value of a partner who understands how technology works in 

the context of our industry and our practice. We’ve relied on 

techCentral solutions and the henry Schein team ever since.”

hittinG A teChnoLoGY StriDe

today, the combination of Dentrix software and 

techCentral solutions plays an even more indispensible role 

at Clay Center Family Dental Care. “We have become a totally 

digital practice,” said Dr. hammel. “that means if our system 

goes down, we can’t see x-rays or view patient records. our 

whole practice basically screeches to a grinding halt. thanks 

to Dentrix and techCentral, that hasn’t happened in a very 

long time, and we’re confident it won’t happen in the future.”

According to nancy hammel, this confidence is grounded 

in two unique techCentral characteristics: the ability to 

recommend and deploy stable, proven technology systems 

created specifically for dental practices and the capacity 

to solve problems quickly and efficiently under any circum-

stances. “When it comes to dental work, we are strong 

believers in doing it right the first time to avoid complications 

and problems down the road,” she said. “techCentral applies 

exactly the same philosophy to the technology we use. every 

time we turn to them for some new addition or improvement, 

we know it will work the way it’s supposed to. As a result, we 

simply don’t have technology issues and downtime like we 

experienced before we started with techCentral.”

the techCentral support team’s unique ability to address 

issues quickly and efficiently using a variety of tools is 

equally important to the hammels. “our practice is located 

in a relatively rural and isolated area, so we simply don’t 

have many technology resources or experts nearby,” nancy 

hammel explained. “With techCentral support, i can always 

Clay Center Family  
Dental Care 
Builds a More efficient and  
Productive digital Practice

case study Clay Center family Dental Care
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reach someone over the phone who knows our systems and our 

situation inside and out. When there’s an issue, they can actually 

take control of our hardware and software to troubleshoot and 

fix problems remotely. henry Schein technicians are always 

happy to visit our offices, but with the people, processes, and 

technology they have in place, that’s rarely necessary.”

WorKinG toWArD extreme eFFiCienCY

When you ask rick and nancy hammel why they have been 

so aggressive about embracing new technology over the 

years—and why they depend so much on Dentrix software and 

techCentral services—the answer always comes back to the 

simple concept of efficiency. “running an efficient, produc-

tive, and profitable practice is crucial to everything we’re 

working to accomplish,” said Dr. hammel. “efficiency enables 

us to take better care of more patients. it allows us to become 

more profitable, so we can provide 

better lives for our employees. And it 

frees up more time and resources to 

give back to our community.”

nothing proves this point better 

than the hammel’s Clay Center Dental 

mission. every year, the practice 

donates a full day of free dental care to 

local people in need. “in 2011, we saw 

more than 100 patients and gave away 

about $35,000 worth of dental care in 

one day,” said Dr. hammel. “the henry 

Schein technology in our office makes 

those kinds of results possible. Without 

Dentrix software and our high-perfor-

mance techCentral network, there’s 

simply no way we could help that many 

people in a single day.” 

this same digital infrastructure also 

helps everyone at Clay Center Family 

Dental Care maintain a healthy work/life 

balance. “thanks to techCentral office 

technology and our Dentrix software, we 

can access patient records and digital 

images from virtually anywhere,” said 

nancy hammel. “our clinicians can 

pull up a patient’s record from their 

home computer or even from their 

smartphones. that’s obviously great for 

patients, but it also gives everyone on our 

staff a lot more flexibility and freedom.”

Clay Center Family Dental Care depends on Dentrix soft-

ware and techCentral services because that combination has 

proven it can deliver concrete results. “We’ve always been 

aggressive about adopting the latest technologies in our 

practice, because we can see the huge potential for improving 

efficiency,” said Dr. hammel. “techCentral always makes sure 

we can turn that potential into reality.”

“Adopting new technology definitely requires a leap 

of faith and change always creates a little bit of stress,” 

continued nancy hammel. “it’s much easier when you can 

put your trust in an organization with a good reputation 

and people who you know will guide you carefully through 

the process. the henry Schein solutions we use—including 

techCentral and Dentrix—have always done that for us. they 

always get it right the first time. And that’s why they’ve earned 

our loyalty.”   

Adopting new technology definitely requires a leap 
of faith and change always creates a little bit of stress. 
it’s much easier when you can put your trust in an 
organization with a good reputation and people who 
you know will guide you carefully through the process.

nancy hammel, office manager
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IN TOucH

Gain a broad overview of the basics. 
Learn step-by-step how Dentrix 
makes daily routines easier and 
more efficient. Designed to help 
newer users master the basics of the 
Appointment Book, Family File, Office 
Journal, Treatment Planner, Ledger, 
Continuing Care, Insurance Manager, 
Office Manager and more!

Learn to increase production through 
effective use of Dentrix clinical 
tools. Discover how to improve case 
presentation and increase case 
acceptance, create multiple treatment 
cases, use the Treatment Planner 
to manage treatment options, use 
customized clinical notes to make 
charting fast and efficient, and learn 
tips for efficient perio charting.

essentials workshoP
Master the basICs

CliniCal workshoP
InCrease baCk-offICe 
effICIenCY

2-day class for newer 
Dentrix users: 9am – 5pm

per 
person$3996

Ce Credits**
1-day class for experienced 
Dentrix users: 9am – 5pm

per 
person$249

work smarter. 
learn how.

Spend a day or two learning from 
an expert and discover how to 

work smarter with Dentrix.

earlY reGistration saVinGs!

When YoU reGIster at least 3 Weeks earlY

Per Class

two workshoP disCoUnt!

reGIster 1 Person for anY 2 WorkshoPs

additional

saVinGs 

sPeCial oFFers

Earn up to
12 CE Credits
Recognized by the ADA and AGD**



Dentrix experts will teach you tips and tricks to:
•	 Automate	time-consuming,	routine	processes

•	 Improve	collections	from	insurance	and	patients

•	 Simplify	workflow,	improve	efficiency,	and	increase	profitability

•	 Improve	scheduling	and	reduce	no-shows

Finding time to learn the latest tips and features in Dentrix 
can be a challenge in your busy schedule. To help you stay in 
touch with what’s new in Dentrix, attend the Insight Seminar 
in a city near you.

You will also learn how to:
•	 Integrate	key	features	and	patient	communication	tools

•	 Utilize	the	top	ten	new	features	in	Dentrix	G4	

•	 Take	advantage	of	the	products	in	your	customer	service	plan

•	 Increase	productivity	with	new	Windows	7	features

You’RE InvItEd to AttEnd A

Space Is Limited. Reserve Your Seat Today!
To see seminar locations and to register visit:

www.dentrix.com/InsightSeminar or call 1-866-367-2711
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